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Introduction 
 

SAP is an ERP (Enterprise Resource Planning) software by the same name of the company.  SAP is a German acronym 
which is spelled in English as “Systems, Applications and Products in data processing”.   

SAP Business One gives you access to real-time information through a single system containing financial, customer 

relationship management, manufacturing, and management control capabilities. The application consists of modules 

that cover these corresponding areas, and more. 

SAP Business One is based on the Microsoft Windows standard. 

There are two versions of SAP: 

 SAP R3 (All in One) for large companies. It has different modules like SD, MM, PM, SF Etc. 

 SAP Business One for Small and medium size companies it has an End-to-End solution for a company. 

Modules of SAP Business One at FF Steel 

 

 Sales  

 Purchasing 

 Production 

 Finance 

 Inventory 

 CRM 

 HRMS & Payroll (Add on) 

 Plant & Maintenance (Add On) 

DASHBOARD 
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MENU BAR 
The SAP Business One menu bar is located at the top of the main window and contains the following menu 
commands: 

 File 

 Edit 
 View 

 Data 
 Goto 

 Modules 
 Tools 

 Window 

The menus in the menu bar change according to the application window that is open at the time. 

 

Keyboard Shortcuts 
You can use your mouse, as well as keyboard shortcuts, to access and navigate through menus. Underlined letters in 

the menu text indicate these shortcuts. To use a keyboard shortcut, hold the Alt key and press the appropriate 

keyboard letter. The relevant menu appears 

 

Application-Specific Menu Functions 
When you launch certain functions of SAP Business One, specific menu entries are added to the Goto menu. These 
menu entries are available for as long as you are using the function.  

FILE MENU 
Use the File menu to select the options described below. 
 

File Menu Fields 

Menu Command Description / Activity 

Close Closes the current window. 

Save as Draft Saves the document as a draft. 

Page Setup 
Let’s you change the orientation of text, select paper source and size, and adjust 
page margins. 

Preview 

Provides a preview window displaying the open document or report based on the 
default layout. If the document or report has a layout created with the Crystal 
Reports software, version for the SAP Business One application as its default, the 
preview opens in Crystal Reports Viewer. 

Preview Layouts 

Opens the Choose Layout window, displaying both Crystal Reports and PLD 
layouts. You can select a layout other than the default layout to view the open 
document or report. If you select a layout created with the Crystal Reports 
software, the document or report is displayed in Crystal Reports Viewer.  

Print (Ctrl + P) Opens the standard Microsoft Windows Print window. 

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451BECBDBA064574E10000000A114A6B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451BECB7BA064574E10000000A114A6B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100244CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100266CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002A4CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100278CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451BECBABA064574E10000000A114A6B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510035BCF465D7AE10000000A11466F/content.htm
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Select Layout and 
Print 

Opens the Choose Layout window, displaying both PLD (standard SAP Business 
One) layouts and layouts created with the Crystal Reports software. Select a 
layout, choose the OK button, and the standard Microsoft Windows Print window 
opens. 

Print Sequence 
Opens the Print Sequence window. Select a print sequence that you want to apply 
to the open document or report, and choose the Print button. 

Send 
Sends messages, e-mails, SMS messages, and faxes directly from SAP Business 
One. 

Export 
Exports data to the defined applications or XML, and converts layouts to PDF, 
text, unformatted text, or image. 

Lock Screen 
Prevents access to your active screen when you are not at your workstation. To 
unlock your session, enter your user name and password.  

Exit (Ctrl + Q) Closes the SAP Business One application. 

 

Edit Menu  

Use the Edit menu to perform standard Microsoft Windows functions. 

  

Edit Menu Fields 

Menu Command Shortcut 

Undo (Ctrl + Z) Reverse your most recent action. 

Redo (Ctrl + Shift + Z) Repeat an action that you just undid. 

Cut (Ctrl + X) 
Remove data from one place in the document, in order to insert it elsewhere 
in the document. 

Copy (Ctrl + C) 
Duplicate data to leave it where it is and also insert it elsewhere in the 
document. 

Paste (Ctrl + V) 
Insert data, which you have cut or copied, at the required place in the 
document. 

Delete (Del) Remove selected data from the document. 

Select All Select the entire field. 

 

View Menu  

The View menu contains options that relate to the display functions of SAP Business One . The open 
window determines which functions are active. 

View Menu Options 

Menu Option Description/Activity 

User-Defined Fields 

(Ctrl + Shift + U) 

Displays user-defined fields that you have previously created in existing tables, 
according to your business requirements. For more information, see User-
Defined Fields.  

System Information 

(Ctrl + Shift + D) 
Displays information in the status bar, such as form number, or item number in 
a database table. 

Pickers Display 
Let’s you activate or deactivate certain picking functions, for example, a list 
selection, a date picker, or user-defined values. For more information, see 
Pickers Display.  

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510FF7BCF465D7BE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510FF7BCF465D7BE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510FF7BCF465D7BE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/FFB16CAE9C004FD5907896B9E628C12B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/FFB16CAE9C004FD5907896B9E628C12B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/FFB16CAE9C004FD5907896B9E628C12B/content.htm
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Indicators Display 
Activated indicators show you which fields can be translated or have user-
defined values, and whether you can choose values from a list.  

Restore Column Width 
Cancels manual changes to column widths in tables and restores default table 
settings. 

Legend (Ctrl + L) 
Displays the colors used for highlighting the dynamic information in the 
Dynamic Opportunity Analysis report.  

Translated Values 

Displays the translated values of fields that have been translated to the 
language selected in the current document. 

This option appears only if the option Multi-Language Support is selected in  

 Administration 

System Initialization 

Company Details 

Basic Initialization 

 

Data Menu 
 

Use the enabled relevant Data menu options while you perform various actions in SAP Business One. For example, 
you can add and delete rows, or scroll between the records, when filling in a table.  
 

Goto Menu 

The Goto menu is active depending on the window that is currently displayed. The choices in the Goto menu are 
links, which enable quick access to the window, reports, and specific fields in the window.  

For example, when you display an A/R invoice, options such as Base and Target Document, Gross Profit, Payment 
Means, and Transaction Journal ... are available. You can access many of the Goto menu options from the Context 
menu. 

Modules Menu 

The Modules menu contains a list of all modules with their related options. The menu options:  

 Are arranged in the same order as the menus in the Main Menu  
 Cannot be modified 
 May be inactive for unauthorized users 

For more information about each of the SAP Business One modules, see Main Menu: Modules Tab. 

  

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44ED7FBF0AE067D8E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44ED7FBF0AE067D8E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B0CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B0CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510027ECF465D7AE10000000A11466F/content.htm
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Tools Menu  

The Tools menu in SAP Business One contains a variety of commands that are either active or inactive, 
depending on the currently open window. 

Tools Menu Options 

Menu 
Options 

Description/Activity 

Layout 
Designer 

Let’s you assign layouts or printing sequences for printing. The option is available when 
most document types or reports are active. For more information, see Layout Designer.  

Preview 
External 
Crystal 
Reports File 

Let’s you preview reports or layouts, created with the Crystal Reports software, that you 
have not yet imported into SAP Business One. 

Form Settings 

(Ctrl + Shift + 

S) 

Displays the Form Settings Window containing a list of all the fields, rows, and tables 
that you can arrange in any particular window.  

  

The options available to each window depend on the window itself. For example, row 
and table options are available in sales and purchasing documents.  

Change Log 
Tracks changes to the authorization system and to different documents and master data 
in SAP Business One. For more information, see Change Log Window.  

Access Log 
Displays the access activity of SAP Business One users. For more information, see Access 
Log Window.  

Queries 
Used to display and organize system and user-defined queries, run the Query Manager, 
and select a print layout for a query.  

My Menu 
Organize or add new options to the user menu. For more information, see Main Menu: 
My Menu Tab.  

My Shortcuts 
Select Customize to define your own shortcuts to frequently used windows in SAP 
Business One, or select one of the previously defined shortcuts. For more information, 
see Customize User Shortcuts.  

User-Defined 
Values (Shift + 
F2) 

Enter values, originating from a predefined search process, to any field i n SAP Business 
One (including user-defined fields). For more information, see User-Defined Values.  

User-Defined 
Windows 

Displays and manages user-defined windows, which contain additional fields that your 
business might require for day-to-day activities. For more information, see User-Defined 
Fields.  

Customization 
Tools 

Displays a list of user-defined tables you have previously created in SAP Business One. 
Your business might require these additional tables for its day-to-day activities. 

Default Forms 
Displays new business logic or new objects in SAP Business One , based on existing 
functionality. For more information, see User-Defined Objects.  

 
 

   

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510036BCF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510036BCF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002E2CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002E2CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506B97F7D720487E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506B97F7D720487E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/F3685A4541A0479D80ADC3890AD329BC/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/F3685A4541A0479D80ADC3890AD329BC/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B7CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B7CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100290CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100290CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100254CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100254CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100254CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100371CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100371CF465D7AE10000000A11466F/content.htm
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mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4510031ACF465D7AE10000000A11466F/content.htm
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Window Menu 
The Window menu enables you to cascade or close all the open windows, to change the color of a window, 
to activate a particular open window, and to display or hide the Main Menu.  
 

Window Menu Options  

Menu Option Description/Activity  

Cascade 
Arranges all the currently open windows so that they partially overlap each 
other.  

Close All Closes all open windows with the exception of Main Menu.  

Color Let you choose a color for the active window.  

Main Menu (Ctrl + 0) 

Sets the SAP Business One Main Menu as the active window.  

This is useful if you have closed Main Menu accidentally, or need to bring it to 
the top of a number of open windows.  

Messages/Alerts 
Overview 

Displays the Messages/Alerts Overview window, which shows your E-mail, SMS, 
and fax messages, and your alerts.  

Calendar 
Displays the Calendar, so that you can view your meetings, telephone calls, and 
other activities.   

System Messages 
Log 

Displays the System Messages Log window where you can see the last error 
messages, according to the definition in the General Settings window.  

 

You can select whether to display all types of messages, error messages, 
warnings, or information messages only.  

   

In addition, when you open a new window, its name is added to the Window menu. You can then activate 

the window from that menu. To switch between two or more open windows, press Ctrl+1, Ctrl+2, and so 

on depending on the number of open windows. 

 

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44F3E86AC4B80486E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44F3E86AC4B80486E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100269CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45100269CF465D7AE10000000A11466F/content.htm
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Help Menu  

The Help menu enables you to access all the documents provided with the release of SAP Business One  
you are currently using; provide feedback about the application and documentation; and submit 
messages to the support center. 

Help Menu Options 

Menu Option Activity/Description 

Documentation 

This menu item encompasses: 

Online Help: to launch the online help of SAP Business One  

Context Help: to launch the online help page that corresponds to the currently 
active window in SAP Business One 

What's This? To launch the description of the field at which the mouse is pointing.  

The option is active only if the field is enabled (not read-only). 

Help Settings: to specify the language of the documentation, and whether to 
launch it from the local machine or directly from the server  

Welcome 
Screen 

Enables you to launch the Welcome screen of the application, which includes useful 
links to documents and training material. 

Support Desk  

Enables you to: 

Look for SAP Notes and calls submitted to the support center 

Submit a message to the support center 

Run the Restore utilities, following explicit instructions from a support consultant 

Your Feedback 

Enables you to submit your feedback about application functionality and/or the 
documentation. 

This option is not for submitting messages to the support center. 

About Displays the exact version and build of SAP Business One that you are using. 

 

Toolbar  
The toolbar, located below the menu bar, is a collection of icons that provide easy access to commonly 
used functions. Active functions are shown in color, while inactive ones are grayed out.  

The functions represented by the buttons are also available in the menu bar.  
To hide or show a toolbar, right-click in the toolbar area and select or deselect, as required. 
 

 
Toolbar Icons 

Icon Description/Activity 

(Preview...) Enables you to view a document before printing. See also Print Preview.  

(Print...) Prints the active document on the specified printer.  

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506B8287D720487E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506B8287D720487E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/34ED979F2D2C47FE836E6ACA09C8AB95/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002ADCF465D7AE10000000A11466F/content.htm
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(E-mail...) 
Displays the Send Message window, in which you add the E-mail address and 
enter the text of the message. 

(SMS...) 
Displays the Send Message window, in which you enter the phone number and 
the text of your SMS message. 

(Fax...) 
Displays the Send Message window, in which you add the Fax number and 
enter the text for the fax. 

(MS-EXCEL) Enables you to export data to Microsoft Excel. 

(MS-WORD) Enables you to export data to Microsoft Word. 

(PDF) Enables you to export data as a PDF (portable document format) file. 

(Launch Application...) 
Enables you to launch different applications directly from SAP Business One. 
See also Launch Application.  

(Lock Screen) Enables you to lock the active screen. See also File Menu.  

(Find) Switches to Find mode. See also Working in the Find Mode.  

(Add) Switches to Add mode. See also Working in the Add Mode.  

(First Data Record) 

Enables you to navigate between objects of the same type. See also Data 
Menu.  

(Previous Record) 

(Next Record) 

(Last Data Record) 

(Filter Table...) 
Enables you to search and display specific data in SAP Business One. See 
Filtering Data in SAP Business One.  

(Sort Table...) Enables you to sort data in a table. See Sorting Data in Tables.  

(Base Document...) Displays a document that has been created on the basis of the selected 
document or as a follow-up to the selected document. For example, you can 
view the original sales quotation or the subsequent A/R invoice from a delivery. 
  

(Target Document...) 

(Gross Profit...) Displays the Gross Profit window for a sales document. See Gross Profit.  

(Payment Means...) Enables you to specify payment means for a document. See Payment Means.  

(Volume and Weight 
Calculation...) 

Calculates the volume and weight of the items in marketing documents.  

(Transaction Journal...) 
Displays the Transaction Journal Report with the summary of all the  accounting 
transactions.  

(Journal Entry 
Preview) 

Enables you to preview the corresponding journal entry posting before you add 
a document that generates journal entry. If adding the document triggers more 
than one journal entry posting, you can preview all at one time. 

 Note 

If transactions are posted to journal entries, for example, by another user, 
during journal entry preview, the final journal entry might differ from the one 
previewed. 

(Layout Designer...) 
Let’s you select a layout or printing sequence and edit layouts for printing 
documents and reports. See Print Layout Designer and Working with the Crystal 
Reports Software. 

(Form Settings...) 
Displays the Form Settings window with the list of options for the active 
window. You can change these settings to modify the fields, rows, and tables 
displayed in a window. Additionally, see Tools Menu. 

(Query Manager...) 
Displays the Query Manager window. For more information about queries, see 
Query Manager.  

(Worklist Messages 
Overview) 

Displays Workflow Worklist window. See Workflow Worklist Window.  

(Messages/Alert 
Overview...) 

Displays the Messages/Alerts Overview window, which displays user messages 
and alerts.  
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mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44EA03D9D54003FEE10000000A1553F6/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45114B9329FC4805E10000000A1553F6/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/45114B9329FC4805E10000000A1553F6/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B7CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/451002B7CF465D7AE10000000A11466F/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/DC2EC90D2741400ABEB4BCDA603B0AD7/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506DA09D8696C30E10000000A114A6B/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/4506DA09D8696C30E10000000A114A6B/content.htm
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(Calendar...) 
The SAP Business One Calendar displays your scheduled meetings, phone calls, 
and other activities. 

(Available to Promise 
Check) 

Displays the ATP Check window. For more information, see Checking ATP.  

 

(Delivery Schedule 
Management) 

Displays the Delivery Schedule Management window. For more information, 
see Scheduling Deliveries.  

 

(Cash Flow Forecast) 

Displays the Cash Flow Forecast window allowing you to view detailed 
information about the incoming and outgoing cash flows. For more 
information, see Cash Flow Forecast Window.  

 

(Pervasive Analytics 
Designer) 

Displays the pervasive analytics designer. For more information about working 
with pervasive dashboards, see the How to Work with Pervasive Analytics guide 
in the documentation area of SAP Business One Customer Portal at 
http://service.sap.com/smb/sbocustomer/documentation 

 

(Context Help...) Displays the SAP Business One online help. 
 

 

 

  

mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44F3E86AC4B80486E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/44F3E86AC4B80486E10000000A155369/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/EE789C4B2B5D40FC8F14F8026ADE5928/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/B74B9701451A41699C8B71E04221ECFF/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/B74B9701451A41699C8B71E04221ECFF/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/7A8EC04BF91445D48C0B40029DF77843/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/7A8EC04BF91445D48C0B40029DF77843/content.htm
mk:@MSITStore:C:/Users/NOUSHE~1/AppData/Local/Temp/Help/EN/SBO_Help.chm::/7A8EC04BF91445D48C0B40029DF77843/content.htm
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fsmb%2Fsbocustomer%2Fdocumentation
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fsmb%2Fsbocustomer%2Fdocumentation
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fsmb%2Fsbocustomer%2Fdocumentation
http://help.sap.com/disclaimer?site=http%3A%2F%2Fservice.sap.com%2Fsmb%2Fsbocustomer%2Fdocumentation
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MAIN MENU 

 

Administration  

 

You can use this module to do as follows: 

 Specify information about your company and user information in the system, such as the following:  
o Currency exchange rates 
o Authorizations and alerts 
o Approvals 
o Internal mail organization, basic E-mail settings and other information 
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o Access information from non-SAP software using data import and export functions 

 Specify system setup and system parameters 

 Perform regular maintenance functions for your system such as backup and restore.  

 

Features 

 Choose Company 

 Exchange Rates and Indexes 

 Initializing the System 

 Setup 

 Data Import/Export 

 Utilities 

 Approval Process 

 License 

 Integration Framework 

 Add-Ons 

 Working With Workflow 

 Setting Up and Working with Alerts 

 Send Message 

 BI OnDemand Integration Configuration 
 

Financials 

This module: 

 Includes all functions and reports required for the accounting and financial operations of the company  

 Includes all tax-related reports according to the regulations in each country 

 Enables you to document all financial and accounting-related transactions 

 

Features 

 Chart of Accounts 

 Journal Entry 

 Journal Vouchers 

 Posting Templates 

 Recurring Posting 

 Reverse Transactions 

 Exchange Rate Differences 

 Conversion Differences 

 Financial Report Templates 

 Journal Voucher Report 

 Working with Fixed Assets 

 Budget 

 Cost Accounting 

 Financial Reports 

 Cash Flow Forecast Window 

https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc2224a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc1c24a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/06b9967d720487e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc6d24a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/06434aaaf40485e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc4324a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/06dab4d8696c30e10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/06434daaf40485e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/d7/dceab0d1ae42b1929ffaf1168a0bf7/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc7624a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/13/a291a101f64ad9bf4b27978097a5db/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/06437557240484e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/05bc6724a70489e10000000a155369/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/58/424cec4e62441a8cced5474dad5180/content.htm
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Sales Opportunities  

The Sales Opportunities module lets you track and analyze pending opportunities according to the progress of 

activities such as meetings, negotiations, and other proceedings in the sales pipeline. 

Comprehensive forecasting methods enable you to project potential earnings and prioritize sales activities.  

Using the various tabs of the Sales Opportunity window you can process a sales opportunity from creation and field 

configuration, through updating and reporting, to closure. 

Some features of this module include being able to do the following: 

 Link a variety of documents 

 Designate an owner for a sales opportunity 

 Select a different owner for each stage of a sales opportunity 

 Determine employee access to the contained information 

 Generate table and graphical reports to provide different formats for analysis  

o Analysis can be per stage, per user, or a high-level overview displayed in the Statistics report. 

o Reports can be filtered by such parameters as business partner, sales employee, and time period. 

 

Features 

 Managing Sales Opportunities 

 Sales Opportunity Reports 

 

Sales A-R 

This module covers the entire sales process, from creating quotations for customers and interested parties, to 

invoicing, creating document drafts, and printing. SAP Business One provides an extensive range of sales documents, 

each of which pertains to a different stage of the sales process. 

You can customize documents to meet special requirements, as follows: 

 Combine different types of content in one sales document by making appropriate settings in the  Form 

Settings window. 

 Perform batch processing of target documents using the Document Generation Wizard. 

 Create letters using the Dunning Wizard to notify customers of their open invoices and to remind them of 

overdue payments. 

 Add predefined text to a document with the built-in text editor. 

 

Features 

 Sales Process in SAP Business One 

 Sales Quotation 

 Sales Order 

 Delivery 

 Return 

 Down Payments 

 A/R Invoice 

 A/R Invoice + Payment 

https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/45/0a574437ca1f2ce10000000a1553f6/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fd949793202463e10000000a1553f7/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fd949793202463e10000000a1553f7/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fd947493202463e10000000a1553f7/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fd94a093202463e10000000a1553f7/content.htm
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 A/R Credit Memo 

 A/R Reserve Invoice 

 Recurring Transactions 

 Document Generation Wizard 

 Draw Document Wizard 

 Managing Document Drafts 

 Document Printing 

 Dunning Wizard 

 Sales Reports 

 Goto Menu - Sales and Purchasing Documents 

 Additional Information 

 

Purchasing A-P 

SAP Business One enables you to manage the entire purchasing process from purchase orders through processing 

A/P invoices. Furthermore, you can create various reports to analyze purchasing information such as purchase 
volume analysis, pricing information, vendor liabilities aging, and so on. 

Features 

SAP Business One supports the following purchasing documents: 

 Purchase Quotations 

 Purchase Order 

 Goods Receipt PO 

 Goods Return 

 A/P Down Payment Invoice 

 A/P Invoice 

 A/P Credit Memo 

 A/P Reserve Invoice 

 Landed Costs 

 
You can customize all purchasing documents to your specific requirements. 

 

Business Partner  

The Business Partners module manages all the information relevant for your relationships with customers, vendors, 
and leads (interested parties), as well as performing and reviewing internal reconciliations for business partners.  

Business Partners and Accounts 

SAP Business One differentiates between business partners and G/L accounts: 

 Business partners are all your company customers, vendors, and leads.  

 G/L accounts are all the entities defined in your company's Chart of Accounts, such as expenses, revenues, assets, 

and liabilities. 

SAP Business One connects between business partners and G/L accounts through control accounts that are defined 

during system initialization, and which may vary for different business partners. 

https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fc22711d3c6c30e10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/f8c608445241aae10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fc227a1d3c6c30e10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/f8c668445241aae10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fc2867270541aae10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/fc225c1d3c6c30e10000000a114a6b/content.htm
https://help.sap.com/doc/saphelp_sbo92/9.2/en-US/44/f8c625445241aae10000000a114a6b/content.htm
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All sales and purchasing transactions are posted to the appropriate control accounts, allowing you to access the 

overall balance, the balance for customers, and the balance for vendors in one G/L account. In  addition, you can 

access the balance of a specific customer or vendor. 

 

Banking 

Use this component to perform all monetary transactions that involve bank accounts, including the following:  

 Manual and automatic creation of incoming and outgoing payments for various payment means 

 Manual and automatic performance of internal and external reconciliations 

 Postdated and cash deposits of checks and credit card vouchers 

 Batch and single check printing 

 

 

Inventory 

Use the Inventory module to optimize inventory management, including the following: 

 Managing item master data records 

 Working with serial and batch numbers 

 Managing Inventory transactions, including goods receipts, goods issues, inventory transfers, initial item quantity 

settings, and inventory counts 

 Managing price lists, including period and volume discounts, and special prices 

 Working with the pick and pack process 

 Generating inventory-related reports 
 

Resources 

The Resources module serves as an extension to the Production module; together they provide a base platform for 

managing light manufacturing processes in SAP Business One. 

Using the resources functionality you can perform the following key business functions:  

 Manage production capacity 

 Monitor complete standard production costing 

 Analyze real production variances 

 Simplify BOM management 

 Use production orders more flexibly 

A resource is a commodity, machine, labor, and so on, used to produce goods and services. As opposed to items, 

resources have capacity available throughout a period of time that can be consumed in a production process. You 

can define daily resource capacity for each day separately or for a period of time, and then you can assign the 

capacity to production orders. Consumption of resources in a production process contributes to overall production 

costs and can be split into underlying cost elements for further accounting purposes.  

 

Production 

Production module is used to create and maintain the following: 

 Bill of Materials (BOMs) - specifies the quantities of components that make up a product. 
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 Production Orders - a set of instructions for planning and assembling a production item. It tracks all the material 

transactions and costs involved in the production process, as well as additional costs, such as labor overhead. 

SAP Business One supports the following types of production orders: 

o Standard - used for regular production. Components are copied from the item BOM. 

o Special - used to produce items or perform activities on the shop floor that are not based on the Standard 

BOM. 

o Disassembly - used to report the disassembly of an item with a production BOM. Components are copied from 

the item BOM. 
 

Material Requirements Planning 

The Material Requirements Planning (MRP) module enables you to plan material requirements for a manufacturing 

or procurement process based on the re-evaluation of existing inventories, demands, and supplies on changing 

planning parameters (such as lead time determination, make or buy decisions, and holi day planning). 

MRP calculates gross requirements for the highest bill of materials (BoM) level, based on existing inventory, sales 

orders, purchase orders, production orders, forecasts, and so on. It calculates gross requirements at the lowest BOM 

levels by carrying down net parent demands through the BOM structure. Dependent levels might have their own 

requirements, based on sales orders and forecasts. 

The results of the MRP run are report and recommendations that fulfill gross requirements by taking into  

consideration the existing inventory levels and existing purchase orders and production orders. The MRP run also 

takes into account predefined planning rules such as Order Multiple, Order Interval, Minimum Order 

Quantity, Inventory Level, and so on. 
 

Services 

If company provides support services to its customers, or receives support services from your vendors, you can 

manage all activities related to those services using the service component.  

For example, you can: 

 Manage the interaction between service representatives and business partners. 

 Maintain information on service contracts, items, and serial numbers as well as customer complaints and 

inquiries. 

 Monitor and manage the activities of your service department by using standard and custom reports th at assist 

managers and support staff with their daily work. 

 Optimize the potential of your sales and service departments and generate additional revenue by supporting 

business functions such as: 

o Service operations 

o Service contract management 

o Service planning 

o Tracking of customer interaction activities 

o Customer support 

o Management of sales opportunities 
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 Create a knowledge base of solutions for issues raised by your customers. You can manage this knowledge base 

according to your items; therefore, when a certain problem reoccurs, you can reduce the time required to solve it 

by searching for solutions by item. 
 

Human Resource 

The Human Resources module to enter and maintain information about company employees, and to perform the 

following related tasks: 

 Enter and maintain general and personal employee information, such as age, marital status, passport and ID 

number, phone numbers, and home and work addresses. 

 Manage information regarding employee education, previous job records, results of professional reviews, and 

absences. 

 Analyze employee costs and salaries. 

 Create various reports and employee lists to run your business more efficiently.  

 

Project Management 

The Project Management module to manage your projects from start to finish, centralizing all project  related 

transactions, documents, and activities. The feature helps you monitor the progress of tasks, stages and phases, 

analyze budget costs, and generate reports on various aspects of the project, such as stage analysis, open issues, and 

resources. 

 

Reports 

SAP Business One contains an integrated and extensive Reports module that includes reports from the following 

modules: 

 Financials 

 Sales Opportunities 

 Sales and Purchasing 

 Business Partners 

 Banking 

 Inventory 

 Production 

 MRP 

 Service 

 Human Resources 

 

SAP Business One contains many predefined reports that you can analyze in various ways by using the selection and 

sort functions. Navigating in a report enables you to quickly access the underlying detailed information that it 

contains.  

You can also export all reports to Microsoft Excel and some to a Microsoft Word document. This capability gives you 

access to data from outside of SAP Business One. 
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